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Microsoft Excel 2019 Fundamentals Workshop

Overview

This manual provides instructions with the fundamental spreadsheet features of
Microsoft Excel 2019. Topics covered in this document will help you become more
proficient with the Excel application. Specific focuses include building spreadsheets,
worksheet fundamentals, working with basic formulas, and creating charts.
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l. Introduction

Microsoft Excel is a powerful electronic spreadsheet program you can use to automate
accounting work, organize data, and perform a wide variety of tasks. Excel is designed
to perform calculations, analyze information, and visualize data in a spreadsheet. Also
this application includes database and charting features.

A. Launch Excel

To launch Excel for the first time:
1. Click on the Start button.
2. Click on All Programs.

3. Select Microsoft Office from the menu options, and then click on Microsoft
Excel 20109.

Note: After Excel has been launched for the first time, the Excel icon will be
located on the Quick Launch pane. This enables you to click on the Start button, and
then click on the Excel icon to launch the Excel spreadsheet. Also, a shortcut for
Excel can be created on your desktop.
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B. Window Features

The purpose of the window features is to enable the user to perform routine tasks
related to the Microsoft applications. All the Office applications share a common
appearance and similar features. The window features provide a quick means to
execute commands. Here are some pertinent Excel features:

1. Quick Access Toolbar 2. Search Bar 3. Title Bar

4_File Tab 10. Ribbon
11. Formula Bar
5. Name Box 88 ' ' " St b "
6.Cell | %
12. Worksheet
7.Cell Range [ """
8. Status Bar o

9. New Sheet Button 13. View Options
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C. Spreadsheet Terms
Term Description

1 Quick Access Toolbar | Displays quick access to commonly used commands.

2 Search Bar Advance search will help you find and perform tasks.

3 | Title Bar Displays the name of the application file.

4 File Tab The File tab has replaced the Office button. It helps you to manage
the Microsoft application and provide access to its options such as
Open, New, Save, As Print, etc.

5 Name Box Displays the active cell location.

6 Cell The intersection of a row and column; cells are always named with
the column letter followed by the row number (e.g. A1 and
AB209); cells may contain text, numbers and formulas.

7 Range One or more adjacent cells. A range is identified by its first and last
cell address, separated by a colon. Example ranges are B5:BS,
A1:B1 and A1:G240.

8 | StatusBar Displays information about the current worksheet.

9 New Sheet Add a new sheet button.

10 | Ribbon Displays groups of related commands within tabs. Each tab
provides buttons for commands.

11 | Formula Bar Input formulas and perform calculations.

12 | Worksheet A grid of cells that are more than 16,000 columns wide (A-Z, AA-AZ,
BA-BZ...IV) and more than 1,000,000 rows long.

13 | View Option Display worksheet view mode.

Microsoft Excel 2019
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D. Mouse Pointer Styles

The Excel mouse pointer takes on many different appearances as you move around the

spreadsheet. The following table summarizes the most common mouse pointer
appearances:
Pointer Example Description

= C= 1 The white plus sign will select a single cell to

EE! selected cell. This pointer is also useful for

enter data, retype data or delete text from the

selecting a range of cells.

The white arrow will drag the contents of the
. selected cell to a new location (drag and drop).

The black plus sign activates the fill handle of

the selected cell and will fill the adjoining cells
with some type of series, depending on the type
of data (e.g., a formula or date) is in the
beginning cell.

E. Spreadsheet Navigation

The following table provides various methods to navigation around a spreadsheet.

Method

Description

mouse pointer

Use the mouse pointer 57 to select a cell.

scroll bars Use the horizontal and vertical scroll bars to move around the spreadsheet to view
columns and rows not currently visible. Click the mouse pointer once the desired
cell is visible.

arrow keys Use the left <, right —, up T, and down | arrows to move accordingly among cells.

Enter Press the Enter key to move down one cell at a time.

Tab Press the Tab key to move one cell to the right.

Ctrl+Home Moves the cursor to cell Al.

Ctrl+End Moves the cursor to the last cell of used space on the worksheet, which is the cell

at the intersection of the right-most used column and the bottom-most used row (in
the lower-right corner).

End + arrow key

Moves the cursor to the next or last cell in the current column or row which contains
information.
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1. Practice moving around the spreadsheet.

2. Practice selecting cells and cell ranges.

F.  Basic Steps for Creating a Spreadsheet

When creating a spreadsheet, it is recommended to do the following steps:

Made a draft of your spreadsheet idea on paper.
Enter the data from your draft onto the actual spreadsheet.

Format your data after entering onto the spreadsheet.

1
2
3
4, Calculate data by using mathematical formulas.
5 Save the document.

6

Preview and Print the spreadsheet.

Microsoft Excel 2019 Page 8 of 52
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Enter and Format Data

Create Spreadsheet

lllustration of spreadsheet to be completed in exercise below:

Budget for Guest Speakers

ltem Fall Spring Summer | Annual

Research 20 20 10 50
Correspondence/Communication 30 30 15 75
Publicity 50 50 25 125
Honorariums 500 500 250 1250
Travel 750 750 325 1825
Lodging 300 300 150 750
Total $1,650.00 | $1,650.00 | $775.00 | $4,075.00

Open Excel Practice File.xIsx , and then click on the Budget sheet

tab. | Budget

Percentage

Im.foice|

(The instructor will indicate the location for this file.)

~Ppao0op

Microsoft Excel 2019
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Select cell A1, and then type Budget for Guest Speakers.
Select cell A3, type Item, and then press the Tab key.
Select cell B3, type Fall, and then press the Tab key.
Select cell C3, type Spring, and then press the Tab key.
Select cell D3, type Summer, and then press the Tab key.
Select cell E3, type Annual, and then press the Tab key.
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B. Adjust Column Width

Initially all columns have the same width in a spreadsheet. Often you will need to make
columns wider or narrower. For example, a long text entry in one cell will be cut
off/truncated when the cell to its right contains any information. Likewise, numbers will
appear as pound symbols ### when larger than cell width. There are several ways to

modify column width.

method

Description

dragging method

A & B

C

|Budget for G;uest Speakers

Move the cursor up to the column heading area and point to
the vertical line to the right of the column that you want to
change. When the cursor becomes a "plus sign" with
horizontal arrows, press the mouse button and drag in
either direction to resize the column. Release the mouse
button to accept the new size.

double click to auto fit

Move the cursor up to the column heading area and point to
the vertical line to the right of the column that you want to
change. When the cursor becomes a "plus sign" with
horizontal arrows, double click to AutoFit this one column.

AutoFit a range

Use the mouse to select the range of cells that needs to be
adjusted and on the Home ribbon in the Cells group,
choose Format, and the select the AutoFit Column Width
option.

1. Increase the width of column A via the dragging method so that all text entries
are visible.
2. Decrease the width of column C via the dragging method until pound symbols
#H# appear.
c
St
20
30
a0
Ciataid
3. Increase the width of column C to return to its original size.

Microsoft Excel 2019
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C. Type Text and Numbers

Use the plus sign mouse pointer to select a cell then begin typing in that cell to enter
data. If there is existing text/data in a cell, the new text will replace the existing text.
Press the Enter or Tab key after typing text in a cell.

1. Type the following text and numbers in rows 10 and 11:
10 |Food a0 a0 45
(11 |Total

D. Undo and Redo

Use the Undo [~ button to undo (reverse) previous actions in reverse sequence.
Choose this option immediately after performing an unwanted action. Note that Undo is
not available for all commands. The Redo [°] button will restore the process
that was just undone.

1. Click on the Undo [*2] button. The last item that you typed is removed from the
spreadsheet.

2. Click on the Redo 7] button. The text that you removed with Undo should be
replaced.
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E. Insert and Delete Rows and Columns

Insert rows and columns to add information between existing rows or columns of

information.
Procedure Description
Add Row Select any cell of the row where you desire to add a new row
above. On the Home ribbon in the Cell group, click on the
Insert button, and then select Insert Sheet Rows. A new roll
will appear above your selected cell row.
Add Column Select any cell of the column letter where you desire to add a

new column to the left. On the Home ribbon in the Cell
group, click on the Insert button, and then select Insert
Sheet Columns. A new column will appear to the left of your
selected column.

Delete Row or Column

Select any cell where you desire to delete a row or column.
On the Home ribbon in the Cell group, click on the Delete
button, and then selected Delete Sheet Rows or Delete
Sheet Columns. The row or column where the cell was
selected will be deleted.

1. Select any cell in column C.

2. On the Home ribbon in the Cell group, click on the Insert drop-down arrow, and
then select Insert Sheet Columns. A new column will appear to the left of your

selected column.

3. Click the Undo [7] button.
4, Select any cell in row 6.
5. On the Home ribbon in the Cell group, click on the Insert drop-down arrow, and

then select Insert Sheet Rows. A new roll will appear above your selected cell

row.

6. Select cell A6, and then type Photocopy Services.

7. Press Tab and complete the additional columns as follows:

Microsoft Excel 2019

B [ ¢ [ D |
75 e 30
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F.  Textand Number Alignment

Microsoft Excel aligns data in a cell in three ways; left, center, and right. Also, a range of
cells can be merged into one cell; this is good for text titles. The default text alignment is
left, and the default number alignment is right. Alignment can be changed by using the
alignment & = = icons located on the Home ribbon in the Paragraph group.
Select a range before changing alignment to more than one cell at a time.

1. Select cell A3, and then click on the Center E alignment button, located on the
Home ribbon.

2. Select the range B3:E3, and the click on the Center E alignment button, found
on the Home ribbon.

3. Select the range A1:E1, and then click on the Merge & Center button, found
on the Home ribbon.

G. Format Fonts

Character formats include changing the font, point size, and style of text or numbers.
The fastest way to change fonts is to use the associated buttons on the Home ribbon:

File Home Insert Page Layout Formulas Data Review View Help jo
™ P = —
[] d Cut Calibri v A == B+ 25 Wrap Text
[ Copy -
Paste 7 . u M A = =
- % Format Painter n - - — - =

Clipboard P Font L Alignment

[
11

Merge & Center

1. Select cell A1, and Increase the point size for the title, by clicking on the drop-
down arrow on the Font size button.

2. Select cell range A3:E3, and then click on the Bold button to bold text.

Note: To select all cells on a worksheet, click the gray reggngle in the upper-left corner of
a worksheet where the row and column headings meet. | ——

Once you select the worksheet, any format changes you make will affect the entire sheet.
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H. Format Numbers

Excel gives many types of numeric formats including currency, percent, comma,
scientific, etc. On the Home ribbon, the numeric formats are in the Number group.
Select the drop-down arrow next to General to view all format types. Select a range of
cell/s before choosing format. In fact, this range can include cell/s that does not yet hold
data.

General l "I
$ - % | %8 3N

MNumber

2"

-

o) F 12

o

1 Fract

102

abi =

1. Select the cell range B4:E12.
2. Click on the Comma [l button, found on the Home ribbon.

3. With that same range selected, click on the Currencym button, found on the
Home ribbon.

4. To display only dollars and no cents, click on the Decrease Decimal Eﬂ button,
located on the Home ribbon.

Note: To remove a number format from cells, select the General format option from the
Number group.
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l. Cut, Copy, and Paste Text

Avoid retyping in Excel by moving or copying text and formulas. The following list
includes commands and definitions involved in cut, copy, and paste.

Command Description
Cut Removes the selected text from the document and places it in the
clipboard (a temporary holding place for the item that has been cut or
copied).
Copy Places a copy of the selected text in the clipboard and leaves the

selected text unchanged.

Paste [} | Places text from the clipboard in the document where the active cell is
rste | located.

Suppose you want to show an identical budget for an additional year. In this exercise,
you will copy data in cell range A3:E13, then paste it to sheet2.

1. Select cell range A3:E13.

2. Click on the Copy button, found on the Home ribbon.

3. CIle on the Copy Sheet | Budget | Copy . Account . Loan Percentage Invoice tab
4. Select cell A3, and then click on the Paste button, found on the Home ribbon.
5. Click on the Undo [ button to clear data from spreadsheet. This sheet will be

used again for another exercise.

Note: When you copy a range, a moving border with appear around the selected area.
Once you paste the data to remove the moving border, double click in any cell outside of
the selected range.
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K. Print a Spreadsheet

Click on the File tab and select the Print option. Preview your spreadsheet on the right-
hand side of the File screen. If you are satisfied with the preview, click the Print button,
otherwise click on the Home tab to return to the document and edited document. (Page
Setup options are covered in the Additional Features section on page 47.)

L. Exit Excel

When you are finished using Excel, use click on the File tab, and select the Exit option
or click on the Close [ Jbutton in the upper right-hand corner of the Excel window. If
your file has recently been saved, Excel will exit promptly. However, if the file needs to
be saved before quitting, Excel will prompt you to save.
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1. Basic Formulas

Microsoft Excel is an electronic spreadsheet that automates manual calculations
involved in accounting and bookkeeping. After you have typed the basic text and
number entries in a spreadsheet cell, Excel can perform the math calculations for you.
You will learn how to create formulas and functions to perform calculations in a
spreadsheet.

Example formulas are: =D15+D18+D21: =B4-B12: =A10/B15: =(B16+C16) *1.07

Do not use any spaces in formulas. Also, when creating formulas, you may choose to
either type the cell address or use the mouse to select the cell address.

A. Create Formula

You can create any type of math calculation on your own using the following
mathematical operators:

Symbol Meaning
= equals - used to begin a calculation
+ addition
- subtraction
* multiplication
division
A exponentiation
( open parenthesis - used to begin a grouping
) close parenthesis - used to close a grouping

The numeric keypad on the right side of the keyboard provides most of these operators.
Excel follows the mathematical order of hierarchy where operators are processed in the
order: negation, exponentiation, multiplication/division, and then addition/subtraction. Use
parentheses to clarify the order of calculation in a formula.
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B. Basic steps for creating a formula:

Click in the empty cell which will contain the formula.

Type an equal sign (=).

Type the cell address or click the cell that contains the first number.
Type the math operator (+ -/ * 7).

Type the cell address or click the cell that contains the second number.
Continue in this manner until the formula is complete.

Use parenthesis for clarification.

© N o a0 s~ wDdhRE

Press the Enter key.

The following image depicts various formulas in an Excel spreadsheet which will
be created in a following exercise:

Budget Actual Variance
Office Supplies a0a 22R =C20-D20
Office Postage 200 255 =C21-D21
Office Equipment & Furniture 800 E79 =C2-D22
Mizcellaneous Supplies 100 71 =C23-D23
Total: =C20+C21+ 22+ 23 =SUM({D20:D23) =C24-D24

C. AutoSum

Adding is the most common math operation performed in Excel. The Home ribbon
includes an AutoSum % button for adding. This button provides a shortcut to typing
formulas.

£ Tell me what you want to do & share

Gener | B B owewyz  tomalz  NomslAco. NomelBUD. NomaBUDG. | ) EX bv O
- =

. $ . Q/ 9 « Conditional Format as Noymal_cus( NoymaLPngas Percent 2 Normal Bad Insert Delete Format Sort & Find &
& 2% | Formatting~ Table~ T, . . | @08 Fiere Selecte

fie M Home [insert  Pagelayout  Formulas
<1 X Cut

Paste EQCDW .

+ <5 Format Painter

Calibri 11 < A A

BIU- - O-A-

Clipboard 5 Font 5 Alignment v Number 5 Styles Cells Editing

Basic Steps for using AutoSum:

1. Move to the empty cell that will contain the formula.

2. Click on the AutoSum button.
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3. Proofread the formula that Excel provides, make any necessary changes.

4. Press the Enter key or click the check mark on the formula bar.

Click back on the Budget sheet | Budget . Copy . Account . Loan . Percentage In‘.-'nice| tab.

12 |Total
13

=SUM(B4:B11)
[ SUM(numberl, [number2], ...} |

1. Select cell B12, click on the AutoSum [E button, and then press the Enter

key.

2. Repeat the AutoSum process for cells C12, D12, E12.

Note: You can copy formulas that refer to empty cells. After you type numbers in the
empty cells, the formulas will be updated.

3. Click in cell B4 and change the amount $20 to $50, and then press Enter key.

Note: Formula results are updated automatically in Excel. As you change any values
that are referred to in a formula, the formula will reflect these changes.

4, Complete the AutoSum process for column E. Click in cell E4.

Lk —

ﬂResearch

Item

5 |Correspondence/Communication

B C o] E
EBudget for Guest Speakers

. Eall Spring | Summer _Annual
L5 2005 20§ 10 |I=5UMB4: D4y
3003 30§ 15

Microsoft Excel 2019
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5. Click on the AutoSum E button to add the Research expenses for the three
semesters.

6. Press the Enter key.

7. Select the cell range B5:E5, click the AutoSum ] button, and then press Enter
key.

75
Ll

8. Auto Fill = | this formula to the cell range E6:E11.

9. Copy this formula to the cell range E6:E11 by using the Auto Fill method illustrated
above. Place the mouse pointer on the small solid square on lower right corner of
cell E5, when the mouse pointer changes to a plus sign (Fill handle), then hold down
on the right mouse button and drag the mouse down the designed cells (E6:E11) to
copy the formula. The Auto Fill feature is explained in more detail in the Additional
Features section on page 44.

Note: If Excel has to make a choice regarding adding values to the left (horizontally) of the
formula cell or above (vertically) the formula cell, it will choose vertically. This can
occasionally present a problem. Therefore, you may decide to select a range including the
values to be added and the empty cell that will contain the formula then click the AutoSum
button.
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D.

Borders and Shading

Use borders to separate different areas of the spreadsheet. Borders can be applied to

one cell or a range of cells. Use the Borders

_El button, on the Home ribbon to apply

border styles. Also, the Fill Color button will add or remove color/shading for a cell

or range.

When you apply borders to data on your spreadsheet, you may want to print the data
without gridlines (applying and removing gridlines is covered in the Preference section).

Microsoft Excel 2019

Select the cell range A12:E12.

e

Borders

Bottom Border

i Top Border
i Left Border
Right Border

All Borders

Clutside Borders

[SE|
=2

Thick Box Border

Select the cell range A12:E12 again.

Use a border to emphasize the Total row for the Budget for Guest Speakers
spreadsheet.

Click on the Border drop-down arrow, located on the Home ribbon, and
then choose the Thick Box Border option.

Click on any single cell to deselect the range to see the border.

Click on the Fill Color drop-down arrow, located on the Home ribbon to add
color/shading to this range.
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E. Manual Formula

You can make manual entries for mathematical formula by typing the numbers, cell
location, and mathematical function in the spreadsheet cell.

Calculate 40% of the publicity

expense (which the

departmental general fund
14 |provides): =0.4*B7

11. Click in Cell B14 and create a formula that will calculate 40% of the Fall publicity
amount (e.g. =.4*B6).

Note: Use the formulabar [% v £ —0.4-g~|to view and edit the data or formula in
the selected cell. The X is to ignore what you are currently typing and return the original
contents of the cell; the green check mark is to accept what you have typed (same as
pressing Enter). These buttons are only available when you are typing in the cell.

Calculate 40% of the publicity
expense (which the
departmental general fund

14 |provides):

15

16 0

201

12.  Copy this formula to the cell the range C14:E14 by using the Auto Fill illustrated
above.
Place the mouse pointer on the small solid square on lower right corner of cell
B14, when the mouse pointer changes to a plus sign (Fill handle), then hold
down on the right mouse button and drag the mouse across the designed cells
(C14:E14) to copy the formula.

Microsoft Excel 2019 Page 22 of 52 Www.pcsdt.in




IV. Formula Functions

Functions provide an automated method for creating formulas in the following
categories: financial, date and time, math and trigonometry, statistical, lookup and
reference, database, text, logical and information. Excel contains more than 200
functions. For example, specific functions are available to calculate a sum, an average,
a loan payment, logarithms and random numbers. Functions can be typed, if you know
the syntax, or can be inserted by clicking on the Function button located left of the
formula bar.

All functions are formatted in a similar manner, for example: = function name
(parameters). The parameters vary depending upon the function. Functions and cell
addresses may be typed in upper case or lower case.

A. Sum

Adding is the most common function performed in Excel. The SUM function adds
values. Specify values, individual cell addresses and/or range addresses in the
numberx variables.

syntax =SUM(numberl,number2,...)
examples  =SUM(A10:A25)

=SUM(B15:C20)
=SUM(D45,D60:D70,D80:D85)

1_ C||Ck on the ACCOUﬂt sheet |Eudget Copy | Account . Loan .~ Percentage . Invoice tab.

2 Select cells C12 and D12, and then click on the AutoSum [2*] button
3. Select cells C24 and D24, and then click on the AutoSum [&] button

4. Select cells C36 and D36, and then click on the AutoSum [&] button
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The following exercises will complete formulas in cells on the Account sheet where
function methods do not apply.

10.

11.

12.

13.
14.

15.

| 4 | 201 Telecommunication Senvices [ 5 850 ] % B35 |=C4-D4 |

Select cell E4, type =C4-D4, and then press the Enter key. This formula will
calculate the difference between cells C4 and DA4.

Auto Fill this formula through the cell range E5:E12.

Select cell E20, type =C20-D20, and then press the Enter key. This formula will
calculate the difference between cells C20 and D20.

Auto Fill this formula through the cell range E21:E24.

Select cell E32, type =C32-D32, and then press the Enter key. This formula will
calculate the difference between cells C32 and D32.

Auto Fill this formula through the cell range E33:E35.

| 43| Grand Total: |[=C12+C24+C36 |

Select cell C43, type =C12+C24+C36, and then press the Enter key. This
formula will calculate the grand total for all budget totals.

Auto Fill this formula to cell D43.

Select Cell E43, type =C43-D43, and then press the Enter key. This formula will
calculate the difference between cells C43 and D43.

Remain on this sheet for the next example.
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B. Insert Function

This selection demonstrates how to use the Insert Function menu to creation a
formula. Click on the Insert Function wci: button or from the AutoSum drop-down arrow
and select More Functions to display a list of over 200 functions available in Excel.
The Insert Function dialog box displays the function categories from the drop-down
menu list. The function names will appear in the function name box below.

Insert Function

Search for a function:

Type a brief description of what you want to do and then Go
click Go
Or select a category: | All ~

Select a function:

SUNMIFS

SUMPRODUCT

SUMSQ

SURMNZMY2 b
SUM({number1,number2,...)

Adds all the numbers in a range of cells,

Help on this fundtion Cancel

Once you select a category and a function name, click on the OK button. The Function
Arguments palette will appear.

Function Arguments

SUM

{1700;1200;300;300;0;0;0:0;0;0;0}

=

|Numher1 32icd2=c2d] b
umber2

= 3500
Adds all the numbers in a range of cells,

Numbert: numberl,number2,... are 1 to 255 numbers to sum, Logical values and
text are ignored in cells, included if typed as arguments,

Formula result = 3500

Help on this function Cancel

Type any numbers, cell addresses, ranges, or any other parameters in the required
boxes, and then click on the OK button to insert the completed formula in the

spreadsheet.
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C. Average

An average sum all values and divides by the total number of values. Specify values,
individual cell addresses and/or range addresses in the numbers variables.

syntax =AVERAGE(nhumberl,number2,...)

examples =AVERAGE(15,255,45)
=AVERAGE(B2:B18)
=AVERAGE(B15,B33,B52)
=AVERAGE(C22:C24,C30:C33)

1. Confirm that Account is active.

2. Insert a function to average the budget items for Subcontractors & Services.
Select cell C14.

3. Click on the Insert Function [ %] button.

Insert Function

Search for a function:

Type a brief description of what you want to do and then Go
click Gao

Or select a categoryy Statistical e

Select a function:

AVEDEV ~
AVERAGEA

AVERAGEIF

AVERAGEIFS

BETA.DIST

BETA.INV v

AVERAGE(number1,number2,...)

Returns the average (arithmetic mean) of its arguments, which can be
numbers or names, arrays, or references that contain numbers.

Help on this function Cancel
4, Choose the Statistical category, and then click on the Function name: Average.

5. Click on the OK button.

6. The Function Arguments palette will appear. Indicate the range C4:C11.
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Function Arguments

AVERAGE
I Numbert | cd:c11| + |= {850;350;100;700; 160; 50;2500;300}
Number2 *|| =
= 626.25
Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays, or references
that contain numbers,
MNumberi: numberi number2,... are 1to 255 numeric arguments for which you want
the average.
Formula result = 626,25
Help on this function Cancel
7. The Function Arguments palette may select a different cell range than you want.

If so, make any necessary changes in the palette before accepting the defaults.

8. Click on the OK button to complete the function.

9. Select cell C26, and then click on the Insert Function button to find the
average of the budget items for Supplies and Materials.

10. Select cell C38, and then click on the Insert Function = button to find the
average of the budget items for Facilities Overhead.

11. Remain on this sheet for the next example.

The Function Arguments palette can be moved around on the screen so that you can
see the intended cell or range. Point to any gray space in the palette and drag the
window around on the screen until you see the desired area in the spreadsheet. You
can also click the range®] button to temporarily remove the palette from the screen so
that you can view the spreadsheet area. A small palette range entry box
Jesici] El| appears and you can select the cell or range as necessary. You
may want to delete any existing information in this box before selecting a new range.
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D. Maximum (MAX)
Maximum indicates the largest value in the designated list of numbers.
syntax =MAX (numberl, number2,...)

examples =MAX (A15:A35)
=MAX (D10:D200, D225:D325)

15 Maximum: |=max(C4:C11)
1. Select cell C15, and then click on the Insert Function :::«: button to calculate the

maximum budget cost for Subcontractors & Services.

2. Select cell C27, and then click on the Insert Function w:«: button to calculate the
maximum budget cost for Supplies and Materials.

3. Select cell C39, and then click on the Insert Function =« button to calculate the
maximum budget cost for Facilities Overhead.

E. Minimum (MIN)

Minimum indicates the smallest value in the designated list of numbers.
syntax =MIN(numberl,number2,...)

examples =MIN(A15:A35)
=MIN(D10:D200,D225:D325)

1. Select cell C16, and then click on the Insert Function wuu: button to calculate the
minimum budget cost for Subcontractors & Services.

2. Select cell C28, and then click on the Insert Function :::: button to calculate the
minimum budget cost for Supplies and Materials.

3. Select cell C40, and then click on the Insert Function =uu: button to calculate the
maximum budget cost for Facilities Overhead.
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F. Relative versus Absolute Cell Addresses

As you move and copy formulas, Excel automatically adjusts the part of the cell
reference in the formula that changes as you move down or to the right. For example,
when you copy a formula from a cell to columns to the right, Excel changes the column
letters in the formula without touching the row numbers. Excel assumes that everything
is relative; that is, relocated and copied formulas will reference information according to
the number of columns and rows they have moved.

There are situations where automatic adjustment of the cell references does not
calculate correctly. This is especially true with percentage formulas where the
denominator should remain constant. A dollar sign ($) placed before the column letter
and row number (e.g. $B$6) will lock the address or make it absolute.

1. Click on the Percentage |Budget Copy . Account . Loan | Percentage In‘.-'oicel sheet
tab.
| 2 |Office Supplies 15 449 |=B2/E6 |
2. Click in cell C2, and then type =B2/B6 to create a formula to calculate the

percentage of Office Supplies costs out of the total cost.

Note: You may want to select the range C2:C6, and then click on the Percent Style
button location in the Number group of the Home ribbon to convert the fractional
numbers to percentages.

A B &
1 Description Cost Percentage
2 |Office Supplies ] 443 13%
3 Furniture & Fixtures 5 700 7 #DIviOI
4 |Office Equipment ] 15938 7 #DNviI
5 |Building Maintenance ] 280 7 #DIviOI
£ Total: § 3,364 7 #DIOI

3. Auto Fill this formula down through the cell range C3:C6. The sheet should
appear as shown above. Notice the errors in cells C3:CB6.

4. Click on each cell individually to read the formula in the formula bar.
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Note: Compress the Ctrl and ) keys (" - accent mark, to the left of the number 1 on
the alphabetic keyboard) to display (and hide) formulas throughout a sheet. More
information on displaying and hiding formulas is in the Reference section of this

document.
A B C

1 Description Cost Percentage
2 |Office Supplies 449 =B2/BG

3 |Furniture & Fixtures 700 =B3/B7

4 |Office Equipment 15935 —B4/B85

5 |Building Maintenance 280 =B5/B9

6 Total: =SUM(B2:B59) —BE/B10

Note: When you encounter an error, an Error @ symbol may appear in the upper left
corner of the cell. When you select the cell with the Error @ symbol, then an Alert
error symbol may display. Click on the Alert error symbol for a list of
options to remedy or ignore the error.

5. The reason that the copied formula resulted in errors is that Excel copied this
formula assuming relative references for each formula (adjusting the
denominator in each cell). Make sure that formulas are not displaying.

6. Select the range C2:C6, and press on the Delete key to clear these formulas.

2 [office Supplies I 445 |=B2/5E55 |

7. Click in cell C2, and then type =B2/$B$6 to create the formula to calculate the
percentage again. The $ sign locks the address or make it absolute.

8. Auto Fill this formula down through the cell range C3:C6. The sheet should
appear as follows:

A B C
1 Description Cost Percentage
2 Office Supplies 5 449 13%
3 |Furniture & Fixtures 5 700 21%
4 | Office Equiprment ] 1935 3%
5 |Building Maintenance ] 2a0 8%
£ |Total: $ 3,364 100%
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AN

9. Press the Ctrl and keys to display/hide formulas:

A, B [
1 Description Cost Percentage
2 | Office Supplies 4449 =BZ/5B%6
3 |Fumiture & Fixtures 700 =B3/§B%E
4 | Office Equipment 1935 =B4/5B%E
& |Building Maintenance 280 =bB5/FB%E
6 |Total: =5UM(BZ2:B3) =B6/FE 15

Note: To make a cell address absolute, click on the F4 key after selecting the cell
location, instead of typing dollar signs ($) in the appropriate location.

G. Payment (PMT) (Optional Exercise)

Payment returns the periodic payment of an annuity based on constant payments and a
constant interest rate.

syntax =PMT(rate,nper,pv)

examples  =PMT(.09/12,360,100000)
=PMT(.09/12,60,18000)

When using interest rates, the rate may need to be converted to a percentage and divided
by 12 (assuming an annual percentage rate). For example, 8.25 percent equals .0825.
This number needs to be divided by 12 (.0825/12) to calculate the rate.

1_ C||Ck on the Loan sheet tab |Budget Copy .~ Account | Loan , Percentage Invoice .

2. Select cell B7. Calculate the payment amount for Plan 1.
3. Click on the Insert Function Z_{ button.

4, Choose the Financial category, and then select the Function name: PMT.
5. Click on the OK button.

6. The Function Arguments palette will appear.
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| PMT

Rate |[b5/100)/12 + || = 0.005208333
MNper | bs * )= 36
Pv b4 + || = 10000
Fv + =
Type -
= -305.3534152

| Calculates the payment for a loan based on constant payments and a constant interest rate,

Pwv is the present value: the total amount that a series of future payments
is worth now.

| Formula result = -305.3334152

i Help on this function Cancel
7. Complete the dialog box as shown:
7. Click on the OK button to complete the function.

8. Select cell C7 and use the Insert Function button to calculate the payment for

Plan 2.
| Pt
Rate | (b5/100)/12 4+ || = 0.005208333
Nper |6 + = 48
Pv | 4+ || = 10000
Fu + =
Type +| =
= -235.9981987

| Calculates the payment for a loan based on constant payments and a constant interest rate.

Pv is the present value: the total amount that a series of future payments
is warth now,

| Formula result = -235.9981987

Help on this fundion Cancel

9. Auto Fill this formula to cell D7.
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V. Charts

Microsoft Excel can display data graphically in a chart. Excel displays values from
worksheet cells as bars, lines, columns, pie slices, or other shapes in a chart. When you
create a chart, the values from the worksheet are automatically represented in the chart.
Presenting data in a chart can make it easier to read and more interesting to interpret.
Charts can also help you evaluate your data and make comparisons between different
values.

Chart Title

== EQUipment Fumniture Office Supplies Travel

A. Enter Data

The following exercise will create a simple spreadsheet that will provide the data from
which a chart will be created.

1 ClICk on the CO py Sheet | Budget | Copy . Account . Loan Percentage Invoice tab
2. Type the information in the cells as shown below:
A B C D E F

1 FY2016 FY2017 FY2018 FY2019

2 |Equipment 8500 6750 7100 9200

3 |Furniture 1200 1400 800 1500

4 |Office Supplies 2450 2350 2400 2275

5 Travel 12500 11750 8000 5500

3
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B. Create a Chart

To create a chart, select the cells that contain the data and text that you want to appear
in the chart.

File Home Insert Page Layout Formulas Data Review View Help £ Tell me what you want to do
D B ERDY Qe =«w OB I 2540 [
PivotTable Recomménded Table Puctu.res Onlme Shapes Icons @yScreenshot Bing People Recommended 5 LR Maps PivotChart
PivotTables Pictures ~ Models' O/JM/Add 1L Maps Graph Charts <D L 5
Tables lllustrations Add-ins Charts F}
2. Select the Insert tab, then in the Charts group, click on the Chart button of your

choose. The chart sub-types will appear which will provide you more chart
options to select from. To view all chart types, click on the dialog box on the
Charts group. The Insert Chart window will appear with all chart types.

sert Ch
Recommended Charts
o L8R (A i e 180 10
. Clustered Column
@ Pie Chart Tite Chart Title
E gar : :
WA Area : :
Iﬁ XY (Scatter) - I I I I - II
@ Map — o - . -_. . II - -
b sock [N T—— [P
42 Surface
& Radar
BE Treemap
@ Sunburst
l[l]:l Histogram
#f  Box & Whisker
] waterfal
= Funnel
|k Combo
Cancel

Select the All Charts tab.

Click on the first Column button in the window.

a M W

Click on the OK button.

6. Your chart selection will appear on the spreadsheet.
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File Home Insert Page Layout Formulas Data Review View Help Design Format £ Tell me what you want

ik E= %D

Add Chart Quick Change l L I | | Il | | l-_ VI,--_I,;; !, e i I L. l | ' L Ij l =
Element» Layout~ | Colors~
Chart Layouts Chart Styles
Chart Title
14000
12000
10000
BO00
6000
Data Labels N
4000
- 2000
Y-Axis: Value . | B - .
FY2016 FY2017 FY2018 FY2019
T mEquipment @ Furniture Office Supplies Travel Legend

X-Axis: Category

7. When the chart appears on the spreadsheet it will have a selection boarder
around it. Charts are similar to graphical images which can be moved and
resized.

8. Practice selecting and unselecting the chart. Click any cell in the spreadsheet
to deselect the chart. Single click anywhere inside the chart border to select the
chart area.

9. Move the chart. With the chart object selected, point inside of the object border

% | . Click and drag to move the chart to a new location (the mouse pointer
changes to a four-way arrow).

10. Resize the chart. With the chart object selected, position the mouse pointer on any
handle and drag in the direction indicated by the double arrow pointer ﬁ .
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C. Chart Tools

Microsoft Excel provides many editing options for your chart. When your chart is
selected, the Chart Tools tab will appear on the Ribbon. This enables you to edit your

chart with a variety of designs, layouts, and formats.

i & | @ = oo IS :
Add Chart Quick Change I L. 'l | Il | I Biiilif I_l.l_!i I L1 I ! Lt l =

Element  Layout~ | Colors~

Chart Layouts Chart Styles

File Home Insert Page Layout Formulas Data Review View Help | Designl Format £ Tell me what you want

1. Click on the Design tab.

a. The Design ribbon allows you to change your chart type, layout, and style.

By selecting the appropriate ribbon button, you can change your chart
Layout, Style, and Type.

[r—
File Home Insert Page Layout Formulas Data Review View Help Design | Format I 2 Tell me what you want to do

Chart Area - N — R <1 Shape Fill - A Text Fill -
& Farmat Selection Ooco- ‘ Abc Abc Abc Abc | Abc | | Abc | - | [Z Shape Outline A A - B Text Outline -
2] Reset to Match Style ALLF — — 7| & ShapeEffects ~ T B Text Effects~
Current Selection Insert Shapes Shape Styles [F] WordArt Styles [F]
2. Click on the Format tab.
a. The Format ribbon allows you to edit the format of your chart. By selecting

Shape Styles and WordArt Styles you can apply a variety of formatting
options within the chart labels and axes groups.
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D. Add Chart Title

When a chart is created from the spreadsheet data the text Chart Title will appear
above your chart data.

14000
12000

10000

8000
6000
4000
2000

FY2016 FY2017 FY2018 FY2015

m Equipment Furniture Office Supplies Travel

1. Click on the Chart Title text box.
2. Select or delete text.

3. Type your desired title. For this class exercise, type Fiscal Year Comparisons.

E. Change Data Values

Charts are linked to the worksheet data and are updated when you change the
worksheet data.

1. Click in cell D5, change the Travel expense to 1000, and press the Enter key.

2. Review the change on your chart.
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F. Create Pie Chart

Noncontiguous cell ranges can be selected from your spreadsheet to view specific data
groupings.

File Home Insert Page Layout Formulas Data Review View Help 2 Tell me what you want to do
] [E e [ _E < B SmartArt 4 i
0.7 Ju‘\ Al L »-l [.— b} .'(‘} ( } E: e HA Get Add-ins —{T ﬂ— [ S 5 14
i {7 i mR & O R 7 N A i 44
PivotTable Recommended Pictures Online Shapes |cons 3D W I My Addsins. ~ Bing People  Recommend LB Maps PwvotCl
PivotTables Pictures = Models - ST = Maps Graph Charts sty ® v *
Tables Iustrations Add-ns 2-D Ple
=
D1 v fe | FY2018 ( k (;r, @:
N O
B 8 C D E F G H | J K L M
—_— 3-D Pie
1 FY2016 FY2017 FY2013
2 JEquipmey 8500 675 9200 CS;
3 JFurnitur 1200 1 1500 =
< Joffice Sy 2450 239 2275 i
5 fTravel 12500 1175 5500 i
N (
7 >
8 /
\D A rart
9

1. Select A1:A5, then compress the Ctrl key, and select D1:D5.

2. Click on the Insert tab, click on the Pie button location in the Chart group, and
then select the first 2-D Pie button from the options panel.

3. Your created Pie chart will appear on the spreadsheet.

Fy2018

m Equipment = Furniture Office Supplies Travel

G. Print Chart
If a chart is not selected on the spreadsheet, then both the spreadsheet data and chart

will print. If a chart is selected on the spreadsheet, then only the chart will print.
Click on the File tab, select the Print option, and then click on the Print button.
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VI. Sort and Filter

A. Sort Data

The sorting feature in Excel allows you to place records in order alphabetically or
numerically. You may specify up to three sort levels (e.g. sort first by state, then by city,
then by last name). Sorts may be ascending (A-Z or 0-9) or descending (Z-A or 9-0).
You should always save the workbook before you sort.

Use the Sort A to Z (ascending) or Sort Z to A (descending) buttons to sort the
records, so that the highest or lowest values are at the top of the column.

3| O

Sort & Find &
Filter = Jelect -

Click on the Invoice sheet |Budget Copy . Account " Loan . Percentage | Invoice | tab

1. Click on any cell within the Department column, and then click on the Sort &
Filter button located on the Home ribbon in the Editing group.

2. Click on the Sort A to Z button, to view data in ascending order.

3. Click on the Sort Z to A button, to view data in ascending order.
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B. AutoFilter

The spreadsheet AutoFilter allows you to view and quickly locate data that meet
specific criteria. This feature is faster and more productive than scroll through your
entire spreadsheet to find specific data criteria. Once the information is filtered, you can
printout the displayed data. Once filtering is turned on, click arrows in the column

header to choose a filter for the column.

1. Click on any cell in the database.

Ax p

zY

Sort & fFind &
Filter = Jelect -

2. Click on the Sort & Filter button, located on the Home ribbon in the Editing

group, and then select the Filter from the options window.

3. Drop-down arrows are placed next to each column field name.

A B C D E F G H
L | Invoice ~ _| Subcoc - Departme@FirstNan ~ | LastNan ~ | Extensi( - | Locati(~| Co{~
Pl sortAtoz Linda Feldman 4857 276 EP  §150
Fl SortZto A Rob Fletcher 652235218 $175
Sort by Color , Katrina Jefferson 7900 265 AH 8130
Melissa Adams 2546 214 CH $62
Sean O'Brien 9243 918 EH 389
Fran Wilson 9951 263 SH §81
Text Eilters ' Susan Hayes 7539 306 SH 360
Search jol William Grant 5799 455 CH 5120
2 select a0 . Alan Thompson 8600 200 SH $79
vl Admissions Peter Fraser 4458 662 EH $45
il“hTZELfﬁ'“ = |Am Devon 3812 4458H  §142
T Toiog, Norman Jones 8426 315 EP  §231
T Chemistry Howard  Snyder 3559 267LS 8213
~I¥ Education Bill Lee 2668 307 CH 545
L enginesring ~ Leslie Gilman 4443 252 SB  $123
Elizabeth Lincoln 7682 318 SH  $225
w | | Shamon  MacArthur 7780 554 CH  $128
Y Yeluu4a/s 432 Admissions Pat Parkes 4682 141 SH $35
0 96100476 Susan Davenport 8665 718 EP $95
1 96100477 Sylvia Dunn 1542 185LS  §114
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10.

Click on the Department drop-down arrow. In the Search display window,
deselect the Select All option, and then select Biology.

Click on the OK button. Now, only records from the Biology department are
listed. Two records should display.

Click on the Filter [[¥]utton next to Department, then deselect Biology and
select Law. Four records should display.

Turn off Filter, click on the Filter X button next to Department again, and select
the Select All option. All records in the database display.

Click on the Subcode drop-down arrow. In the Search display window, deselect
the Select All option, and then select 521.

Click on the OK button. Now, only records from the 521 Subcode are listed.
Three records should display.

Turn off Filter, click on the Filter ¥ |button next to Subcode, then deselect 521
and select the Select All option. All records in the spreadsheet database
display.

You can choose one item from many different fields to narrow down a search. For
example, to display all of the Smiths who work in the Law department, filter both of these
fields set to the desired criteria.
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C. Custom Filter

When you need more flexibility in choosing records, use the Custom Filter option. The
Custom option provides the ability to use math operators such as “less than,” “greater
than,” and “does not equal.” You can also select two conditions using the And or Or
options. And will find records that meet both criteria, while Or will find records that meet
either criteria.

e LastName Extension Location Cost
I+ | Feldman [~ 48/~ (276 EF - | S1EZ])
ﬁl Sort Smallest to Largest
ﬁl Sort Largest to Smallest
Sort by Color 3
[ rumoer gitcers Pl Eauas.
fsl Does Not Equal...
(Select All) -~ Greater Than...
v $35 Greater Than Or Equal To...
[ 845
[ 550 Less Than...
[w] 552 Less Than Or Equal To...
[ 72
S8t Between...
[ 589 Top 10..
:glgu - Above Average
=g Below Average
oK Cancel I Custom Eilter... l
1. Click on the Cost drop-down arrow, click on the Number Filters option, and then

select Custom Filter option.

2. The Custom AutoFilter window will appear.

Custom AutoFilter

Show rows where:

Cost

l is greaterthan VIIS1DD vI

®and O or
~| || w
Use 7 to represent any single character
Use * to represent any series of characters
Cancel
3. Create a custom filter that will display records that have a cost that is greater

than 100. Select is greater than from the first operator drop-down arrow in the
Show rows where: section.

4. Click the drop-down arrow to the right of the Show rows where: box. Scroll
through the numbers and select 100.

5. Click on the OK button. 17 records should appear.

6. Turn off AutoFilter.

Microsoft Excel 2019 Page 42 of 52 Www.pcsdt.in



VIl. Additional Features

A. Auto Fill

Excel has an Auto Fill feature that automatically completes data in a series. This data
includes numbers, formulas, sequential dates, week days, months, and years. To use
Auto Fill to copy data, place the mouse pointer on the small solid square (fill handle) on
lower right corner of the cell you desire to copy, when the mouse pointer changes to a
plus (+) sign, then hold down the right mouse button and drag the mouse across the
cell/s to copy data in series desired.

1. Click in a blank cell (with plenty of blank cells to the right or below).

2. Type the word Monday.

3. Position the cursor over the fill handle.
Manday
4, Hold the mouse button down as you drag across or down to complete a series

such as Monday - Friday.

5. Release the mouse button.

B. Named Ranges

When cell or range names become tedious to memorize in a spreadsheet, use the
Named Ranges feature. Named Ranges provide a word method of referring to cell
addresses. For example, you may frequently need to print a range that is difficult to
type or remember. Use the Name Box to create a name for a range.

1. When a cell range is selected the first cell location will appear in the Name box.

A19 Iv J= | Supplies and Materials

A B C D E F
19 |Supplies and Materials Budget Actual Variance
20 301 Office Supplies $ 300 § 226 § T4
21 302 Office Postage 5 200 § 255 §  (55)
22 303 Office Equipment & Fumiture § 800 $ 679 § 121
23 304 Miscellaneous Supplies 5 100 % ™ § 29
24 Total: $1,400 $1,231

26 Average: $ 350 § 308
27 Maximum: $ 800 § 679
28 WMinimum: $ 100 § 71
29

o
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2. Click on the cell location that appears in the Name box. The cell location will
appear selected.

s -
3. Type your desired name, example: Supply and press the Enter key.
4, Select a cell anywhere on spreadsheet.
a1l -
5. Click on the Name box drop down arrow, the name you entered will appear on a
menu list. Select your desired name and the cell range associated with the name

will appear.

Note: Guidelines for naming ranges

e The first character of a name must be a letter or an underscore character.
Remaining characters in the name can be letters, numbers, periods, and
underscore characters.

e Names cannot be the same as a cell reference, such as FY99, Z$100 or
R1C1.

e Spaces are not allowed. Underscore characters and periods may be used as
word separators; for example, First.Quarter or Sales_Tax.

¢ A name can contain up to 255 characters.

e Names are not case sensitive in Excel. For example, if you have created the
name Sales and then create another name called SALES in the same
workbook, the second name will replace the first one.

C. Freeze Panes

Freeze Panes is an Excel feature that allows you to keep row or column titles on the
screen while you scroll through long lists on a worksheet. Freezing panes on a
worksheet does not affect printing.

File Home Insert Page Layout Formulas Data Review View Help £ Tell me what you w4

Iﬁ [ Formula Bar C>\ [ﬂ?ﬂ %‘\ +[j E ESplit

[ Hide

Normal Page Break Page Custom [ Gridlines [7] Headings Zoom 100% Zoomto New Arrange] Freeze
Preview Layout Views J Selection | Window All JPanes

Workbook Views Show Zoom
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1. To freeze panes, click the cell where you want to freeze the rows and/or columns
(to the immediate right of the desired column and/or below the desired row).

2. Select the View tab, click on the drop-down arrow next to the Freeze Panes
button, and then select the Freeze Panes option.

3. To remove these panes, Select the View tab, click on the drop-down arrow next
To the Freeze Panes button, and then select the Unfreeze Panes option.

D. Auto Format

Excel includes numerous pre-defined formats you can quickly apply to the design of
your spreadsheet.

file || Home [ insert  Pagelayout Formulas Data  Review View Help O Tell me what you want to do

T

- 25, Wrap Text General - @ @ Currency 2 Normal 2 Normal_Acco.. Normal_BUD.

§ [®copy ~
Paste === == < ConditionaljlFormat 3 Normal_Cust.. Normal_Prices Percent 2 Normal
B IU- O AL | === == Bm - -9 2 | |

S Format Painter L e === 2= erge & Center $-% 9 3 5 e

Calibri S AN ==

Clipboard & Font n Alignment [} Number

E. Page Setup

Excel allows you to setup the page layout of your spreadsheet to be viewed on screen
or printout. Click on the Page Layout ribbon, and then click on the Page Setup dialog
box button to setup the best way to layout your data for your printout.

File Home Insert |Page Layout Formulas Data Review
ECDIDrs' @ o P o
pD 0 L™= ﬁ@

A|Fonts~ . . . . . .
Themes Margins Orientation Size  Print  Breaks Background Print
- Effects - - - *  Arear v Titles
Themes Page Setup P
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1. Page tab

Page Setup

" Margins  Header/Faoter  Sheet

Orientation
(®) Portrait () Landscape

Sealing
@Adjustto: 100 3% normal size

(O Fitto: 1 + | page(s) wide by |1

Paper size: Letter (8.5 x 117

Print guality: | 600 dpi

First page number: | Auto

> tall

Print... Print Preview

DOptions...

Cancel

a) Orientation section: Click on the Landscape button to change from Portrait, and

then click on the OK button.

b) Scaling section: Click on the Adjust to: button, and type a number smaller than
100 (e.qg., type 85 to have Excel reduce the fonts and size of your data to 85% of the
original amount). Click on the Fit to: button, and type in the number of pages that
you want your data to print on (e.g., wide represents pages going horizontally across
your spreadsheet and tall represents pages going vertically down your spreadsheet);
Excel will automatically determine the scaling percentage needed. Click on the drop-
down arrow on the Paper Size window to change to legal.
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2. Margins tab

Because scaling is flexible, it is not very common to change the margins of the
spreadsheet. However, the Center on Page (Horizontally and Vertically) feature is

nice, especially if you are printing data that does not take up the entire printed page.

Page Setup

Header/Footer Sheet
Top: Header:
0.75 = 03 =
Left: Right:
07 |5 07 =
Bottom: Footer:
075 = 03 =
Center on page
|:| Haorizontally
[ vertically
Print... Print Preview Options...
a) In the Center on page, click on the Horizontally and/or Vertically button to

center your document horizontally and/or vertically.

b) Click on the OK button.
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3. Header/Footer tab

A Header is information that prints at the top of each page in the printout, while a
Footer is information that prints at the bottom of each page in the printout. Both
Headers and Footers are divided into three text placement areas: left, center and right.
These three areas allow you to separate and align the information. Excel's default
Header and Footer are blank.

Page Setup

Page Margins

Header:

[none) ~
Custom Header... Custom Footer...

Footer:

[none) ~

D Different odd and even pages
|:| Different first page

Scale with document

Align with page margins

Print... Print Preview Options...

a) To add information in the Header or Footer, click on the Custom Header or
Custom Footer button, and then type your desired text in the box provided.

b) Click on the OK button.
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4. Sheet tab

The Sheet tab contains items like print areas, print titles, print items and page order.
Use Print area will set a specific range of cells to print as the default. Print titles
section will place rows and/or columns of data that print at the top of each page. The
Print section on the Sheet tab is helpful for turning Gridlines on or off (gridlines are the
thin lines which surround each cell). Page order section will control the order in which
data is numbered and printed when it does not fit on one page.

Page Margins  Header/Footer ShEEtE

Frint area: +
Print titles

Rows to repeat at top: +

Columns to repeat at left: +
Print

[] Gridlines Comments: (Mone) w

[] Black and white :

Cell errors as: | displayed e

[ ] Draft guality
|:| Row and column headings

Fage order
Down, then over |E=f= Eai==
@b EE [EJE; ER
() Over, then down | ==fiz=jl==
EEE] [SEE

Print... Print Preview Dptions...
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F.

Page Breaks

When a spreadsheet is printed or previewed for the first time, Excel defines the print
area and determines page breaks as necessary. A page break occurs when data
cannot fit on one page. These automatic page breaks appear as dashed lines in the

worksheet.

If the pages are not separated at the location you desire, then you can

insert both vertical and horizontal manual page breaks. Excel provides a Page Break
Preview for managing page breaks.

File Home Insert Page Layout Formulas Data Review View Help £ Tell me what you want to do
m - m; +j g *mm ) split [0 View Side by Side e ,_:4
] = 1| o 5
IE] Formula Bar CD\ O\ |Z] i (_’il ,g
NormalPage Break] Page Custom [ Gridlines teadings Zoom 100% Zoom to New Arrange Freeze Switch Macros
Preview fllayout Views g Selection | Window All  Panes~ i Windows ~ x;
Workbook Views Show Zoom Window Macros
1. Select View tab and click on the Page Break Preview button.
2. The Page Break Preview window will appear. Thick blue lines indicate Page
breaks and page numbers are illustrated by watermark gray text.
Eiscal Year 2010 Eiscal Year 2011
Ezpense Sl Arg Fep fet Ner Dee - Feb M Asr  Mar Jrx Sl Arg Fep fet Ner Dec - Febr  Mar Aer Moy e |
Telephone Lines 230 300 33 400 30 243 333 505 403 3T 150 e 260 32 44 415 322 253 413 523 421 330 136 136
Fax Lines 125 210 00 250 220 130 300 213 150 160 it} 57 130 215 04 260 223 13 a2 230 156 156 14 53
Phatocopicr Fental 300 35 250 @0my _ 2g5 W0 3 21 s 44 sz stz 328 260 208 254 T 6447y 334 24 % 46 3
Faper Supplics 43 53 35 45 4 27 3] &0 3 24 15 El 44 55 36 47 Ll a8 B 62 38 24 16 El
Yoice Mail 36 43 50 & 47 3T ) % &l 56 23 H 33 47 52 62 4d 34 62 3 63 53 23 B
Tatal 55 323 TEE 355 46 57§ 1174 124 G687 £30 342 304 185 353 T35 333 &80 2] 1221 1230 a02 i) 356 36
Prai d Girowth Biabe jz 4

To move the page break to your desired location, position the mouse pointer on

the blue line, hold the right mouse button down, and then drag to the desired

location.
4, To return to the normal spreadsheet view.
File Home Insert Page Layout Formulas Data Review View Help £ Tell me what you want to do
n = T * =
B (5| e e | Q[ B | 1] B BB S 3|
Lo [ Hide s 3 L)
NormaljPage Break Page Custom [ Gridlines tieadings Zoom 100% Zoomto New Arrange Freeze Switch Macros
Preview Layout Views g Selection Window All Panes~ [_| i Windows ~ v
Workbook Views Show Zoom Window Macros

5.

Click on the Normal button, located on the View ribbon.
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G. Display Formulas

At times you may want to display the contents of cells containing formulas since
formulas only appear when they are being typed or edited. A printout of the spreadsheet
with the formulas displayed may be helpful for backup or formula troubleshooting
purposes.

A B ] © T
1 Budget for Guest Speakers i
2
3 ltem Fall Spring Sut
4 |Research 20 20 10
5 |Correspondence/Communication 30 30 15
6 |Publicity 50 50 25
7 |Honorariums 500 500 250
8 |Travel 750 750 325
9 |Lodging 300 300 150
10 |Food =T =T 15
11 Total [ =SUM(B4:B10) =3UM(C4:C10) =SUM(D4
12
Calculate 40% of the publicity expense {which the departmental
13 |general fund provides): =0.4*Bb
14 | Average | =AVERAGE(ES A1) =AVERAGE([CA: C11) =AVERA(
1. Select the Formulas ribbon, click on the Show Formulas button, located on the

Formula Auditing group. The formulas will appear on your spreadsheet as
seen in the figure above. Use this same command sequence to turn off the
display of formulas.

File Home Insert Page Layout I Formulas I Data Review View Help £ Tell me what you want to do

ﬁ Z @ O Define Name ~ EﬁTrace Precedents lf’_' Calculate Now

5 Trace Dependent - %
Insert  AutoSum Recently Financial Logical Text Date& Lookup& Math&  More Name Hliace DepenccntR Lot tccng Watch

Calculation B 1 ate Sheet
Function - Used ~ ~  Time~ Reference~ Trig~ Functions~ | Manager B Create from Selection | [ Remove Arrows ~ (%) Evaluate Formula  Window | Options~ =0
Function Library Defined Names Formula Auditing Calculation

Note: The keyboard shortcut for this feature is Ctrl and ) (accent mark character, to
the left of the number 1 key on the alphabetic keyboard).
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H. Range Finder

Range Finder makes it easy to trace, modify, and understand which figures make up a
formula.

4 |Research 5 20
5 |Correspondence/Communication § 30
B |Publicity
7 |Honorariums $ &00
8 |Travel $ 780
9 |Lodging $ 300
10 |Food E] a0
11 Total $ 1,740
12

Calculate 40% of the publicity

expense (which the departmenta
13 |general fund provides): =0.4 * 55

1. Double click on cell that contains an equation (or click on the cell and press F2).

Each part of the equation is highlighted with its own color so you can see the
pieces of the formula at a glance. The Range Finder also works with data used in
a chart. For example, if you click on a data series on a bar chart, the range in
your original data is highlighted. Range Finder also allows you to use drag and
drop to modify your formula or chart range.

VIIl. Advance Search

To get help click in the Advance [.o_Tell me what you want o do|  g@grch box, on the top
center of the Excel window. Type the excel function that you desire and the command
window with appear. For example, if you type in Chart, the Insert Chart window will
appear to help you perform the task.

Clustered Column
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